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Notice
Cabletron Systems reserves the right to make changes in specifications and other
information contained in this document without prior notice. The reader should in all
cases consult Cabletron Systems to determine whether any such changes have
been made.

The hardware, firmware, or software described in this manual is subject to change
without notice.

IN NO EVENT SHALL CABLETRON SYSTEMS BE LIABLE FOR ANY
INCIDENTAL, INDIRECT, SPECIAL, OR CONSEQUENTIAL DAMAGES
WHATSOEVER (INCLUDING BUT NOT LIMITED TO LOST PROFITS) ARISING
OUT OF OR RELATED TO THIS MANUAL OR THE INFORMATION CONTAINED
IN IT, EVEN IF CABLETRON SYSTEMS HAS BEEN ADVISED OF, KNOWN, OR
SHOULD HAVE KNOWN, THE POSSIBILITY OF SUCH DAMAGES.

Copyright © January 21,2000 by Cabletron Systems, Inc. All rights reserved.

Printed in the United States of America.

Order Number: 903217101

Cabletron Systems, Inc.

P.O. Box 5005

Rochester, NH 03866-5005

SPECTRUM, the SPECTRUM IMT/VNM logo, DCM, IMT, and VNM are registered
trademarks, and SpectroGRAPH , SpectroSERVER , Inductive Modeling
Technology , Device Communications Manager , and Virtual Network Machine
are trademarks of Cabletron Systems, Inc.

Ethernet is a trademark of Xerox Corporation.

Virus Disclaimer
Cabletron Systems makes no representations or warranties to the effect that the
Licensed Software is virus-free.

Cabletron has tested its software with current virus checking technologies.
However, because no anti-virus system is 100% reliable, we strongly caution you to
write protect and then verify that the Licensed Software, prior to installing it, is
virus-free with an anti-virus system in which you have confidence.

Restricted Rights Notice
(Applicable to licenses to the United States Government only.)

1. Use, duplication, or disclosure by the Government is subject to restrictions as
set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013.

Cabletron Systems, Inc., 35 Industrial Way, Rochester, New Hampshire 03866.

2. (a) This computer software is submitted with restricted rights. It may not be
used, reproduced, or disclosed by the Government except as provided in
paragraph (b) of this Notice or as otherwise expressly stated in the contract.

(b) This computer software may be:

(1) Used or copied for use in or with the computer or computers for which
it was acquired, including use at any Government installation to which
such computer or computers may be transferred;

(2) Used or copied for use in a backup computer if any computer for which
it was acquired is inoperative;

(3) Reproduced for safekeeping (archives) or backup purposes;

(4) Modified, adapted, or combined with other computer software, provided
that the modified, combined, or adapted portions of the derivative
software incorporating restricted computer software are made subject
to the same restricted rights;

(5) Disclosed to and reproduced for use by support service contractors in
accordance with subparagraphs (b) (1) through (4) of this clause,
provided the Government makes such disclosure or reproduction
subject to these restricted rights; and

(6) Used or copied for use in or transferred to a replacement computer.

(c) Notwithstanding the foregoing, if this computer software is published
copyrighted computer software, it is licensed to the Government, without
disclosure prohibitions, with the minimum rights set forth in paragraph (b) of
this clause.

(d) Any other rights or limitations regarding the use, duplication, or disclosure
of this computer software are to be expressly stated in, or incorporated in,
the contract.

(e) This Notice shall be marked on any reproduction of this computer software, in
whole or in part.
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Introduction

This section introduces SPECTRUM Device Management documentation for SmartSw

e section is organized as follows:

Purpose and Scope 
Required Reading
Supported Devices (page 8)
The SPECTRUM Model (page 12)

urpose and Scope
e this documentation as a guide for managing 
artSwitch 6000 devices with the SPECTRUM 

anagement modules SM-CSI1076, SM-CSI1082, 
d SM-CSI1088. The documentation describes 
e icons, menus, and views that enable you tor 
motely monitor, configure, and troubleshoot 
artSwitch 6000 devices through software 

odels in your SPECTRUM database.

ly information specific to the supported 
anagement module is included under this topic. 
r general information about device 
anagement using SPECTRUM and for 
planations of basic SPECTRUM functionality 

and navigation techniq
documentation listed u

Required Read
To use this documenta
be familiar with the inf
other SPECTRUM onlin
list below:

• Getting Started w
Operators

• Getting Started w
Administrators

• How to Manage Y
SPECTRUM

• SPECTRUM Views

• SPECTRUM Menus

• SPECTRUM Icons
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 is designed with a fully 
rchitecture within each 
he modules to be managed 
a single module acting as a 
ssis, see odesManagement 

 provides port mirroring, 
st control, Quality of 
nd topology protocol, all in 
d mode or Cabletron’s 
onal RMON support is also 

 can provide the following 

rnet

t or Fast Ethernet

plinks

nd OC-12 switched ATM
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upported Devices
e SPECTRUM management modules SM-1076, 
-1082, SM-1088 currently allow you to model 

e following Chassis and SmartSwitch 6000 
vices:

The 6C105 Chassis (page 10), which is a 
modular chassis that can incorporate two 
load sharing power supplies and up to five 
SmartSwitch 6000 modules.

The SmartSwitch 6000 Modules (page 11), 
which include Ethernet, Fast Ethernet, 
Gigabit Ethernet, and Carrier modules.

Optional High Speed Interface Modules 
(HSIM), Very High Speed Interface Modules 
(VHSIM), and Fast Ethernet Port Interface 
Modules (FEPIM) that plug into the 
SmartSwitch 6000 modules and provide high 
speed backbone interfaces to Fast Ethernet, 
FDDI, ATM, WAN, and Gigabit Ethernet.

Networking Char
The SmartSwitch 6000
distributed switching a
module, which allows t
as a single entity, with 
proxy agent for the cha
Modes (page 9).

The SmartSwitch 6000
port trunking, broadca
Service (QoS), VLAN, a
either traditional 802.1
SecureFast mode. Opti
available.

The SmartSwitch 6000
port connectivities:

• Switched Ethernet

• Switched Fast Ethe

• MicroLAN Etherne

• Gigabit Ethernet u

• OC-3, DS-3/E-3, a

ote:ote:

This guide does not provide device 
management information for the HSIM 
and VHSIM Interface Modules.
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modules) for security 
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cons created. 
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anagement Modes
u can configure the SmartSwitch 6000 to 
erate in three management modes: Distributed, 
andalone, and Mixed.

istributed Mode
 this mode, the 6C105 chassis can be viewed as 
ingle entity with a single IP address. The 
assis management functions are distributed to 
 installed modules. This means that a single 
odule in the chassis (such as a 6E233-49) can 
 used to manage all installed modules. You 
nfigure all of the modules in the chassis to the 
stributed mode and assign a single IP address 
 the chassis. SPECTRUM discovery and 
odeling results in a single Device icon being 
eated in the Topology view for each 
anagement module. This icon represents the 
anaging module. SPECTRUM management of 
e modules is through these Device icons.

Standalone Mode
In this mode, each inst
own management func
the modules in the cha
and assign separate IP
module. SPECTRUM m
representative Device i
module during discove

Mixed Mode
This mode provides a m
isolating a module (or 
purposes. You set an I
and configure all non-s
Distributed mode. The 
IP address and is confi
SPECTRUM manageme
representative Device i

ote:ote:

Refer to the appropriate SmartSwitch 
6000 module user’s guides for 
instructions on configuring the modules 
for these management modes.
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105 Chassis
gure 1 shows the chassis with two power 
pplies installed and no SmartSwitch 6000 
odules installed.

hen installed, the modules interface to the 
ame Transfer Matrix (FTM) backplane in the 
assis, thus each module has a separate, 
dependent backplane connection to every other 
odule in the chassis.

Figure 1: Smart

Smart
SWITCH

6000

Smart
SWITCH

6000

Smart
SWITCH

6000
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 the front panel ports and 
ctivities listed in Table 2.

ries Connectivities

Connectivity

orts via RJ45s plus two FEPIM 

orts via RJ45s plus one HSIM 

orts via two telcos plus two 

orts via two telcos plus one 

MF STs plus two FEPIM slots

MF STs plus two FEPIM slots

MF STs plus one HSIM slot

MF STs plus one HSIM slot

10BaseT ports via RJ21 telcos 
 slots

10BaseT ports via RJ21 telcos 
M slot

orts via RJ21 telcos plus one 
t r o d u c t i o n
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martSwitch 6000 Modules
e modules are divided into three groups 
presenting three technologies: Ethernet, Fast 
hernet, and Carrier. The groups are supported 
 SPECTRUM Management Module products as 
ted in Table 1.

ost of the SmartSwitch 6000 modules include 
ts for optional HSIMs, VHSIMs, or FEPIMs.

l modules support all nine levels of RMON and 
bletron’s SecureFast network services.

6E Ethernet Modul
These modules provide
interface uplink conne

Table 1: SPECTRUM Products

Product Module Group

SM-CSI1076 6E Ethernet modules

SM-CSI1082 6H Fast Ethernet modules

SM-CSI1088 6M Carrier Module

Table 2: 6E Se

Module

6E122-26 24 10BaseT p
slots

6E132-25 24 10BaseT p
slot

6E123-26 48 10BaseT p
FEPIM slots

6E133-25 24 10BaseT p
HSIM slot

6E128-26 24 ports via M

6E129-26 24 ports via S

6E138-25 24 ports via M

6E139-25 24 ports via S

6E123-50 48 MicroLan 
plus 2 FEPIM

6E133-49 48 MicroLan 
plus one HSI

6E233-49 48 Ethernet p
HSIM slot
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Fast Ethernet Modules
ese modules provide the front panel ports and 

terface uplink connectivities listed in Table 3.

6M146-04 Carrier M
This is a SmartSwitch 
provides two HSIM slo

The SPECTRU
SPECTRUM lets you m
individual modules or 
network installed in, or
The models provide ac
needed to manage the 
software emulation of t

Table 3: 6H Series Connectivities

Module Connectivity

H122-08 Six 10/100Base-TX ports via RJ45s plus 
two FEPIM slots

H122-16 16 10/100Base-TX ports via Cat 5 RJ45 
UTPs

H128-08 Six MMF SC ports and two FEPIM slots

H129-08 Six SMF SC ports and two FEPIM slots

H202-24 24 10/100 Fast Ethernet ports via RJ45s

H252-17 16 10/100 Fast Ethernet ports via RJ45s 
and one VHSIM slot

H133-37 Three RJ21 telcos (12 ports each in any 
combination of auto-negotiating 10BaseT 
Ethernet or 100BaseT Fast Ethernet) plus 
one HSIM slot

6H133-37 Three RJ21 t
combination 
Ethernet or 1
one HSIM slo

6H203-24 24 port 10/1
RJ21 ports

6H253-13 12 port 10/1
RJ21 connec

6H258-17 16 MMF port
one VHSIM s

6H262-18 6 fixed RJ45

Table 3: 6H Se
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tributes and functionality. Refer to Modeling 
age 61) for modeling instructions.

e model type designators for the SmartSwitch 
00 use an underbar to replace the dash in the 
vice model number. For example, 6E122_26 
fers to the model type for the 6E122-26 module.

ECTRUM’s AutoDiscovery (as well as manual 
odeling procedures) results in the creation of 
vice icons that represent the modules. These 
ns provide double-click zones and Icon 
bviews menus that let you access views 

splaying performance and configuration 
formation.

gure 2 shows examples of the icons and Icon 
bviews menu. 

Figure 2:

10
1

.1
.01

IP Address

6H203_24

IP Address

6H203_24
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iews Summary
vice icons provide access to views, subviews, 
d tables that let you manage the modeled 
vice. Figure 2 shows a general example of the 
n Subviews menu for a Device icon. The views 
ted below are accessible directly from this 
enu and are described individually in 
bsequent sections of this documentation.

Performance Views (page 18)
Chassis Device View (page 21)
Interface Device View (page 30)
Backplane Device View (page 32)
Physical Device View (page 36)
Device Topology View (page 37)
Fast Ethernet Application View (page 40)
FddiMAC Device Configuration View (page 49) 
(available with optional HSIM)
ATM Client Application (page 41) (available 
with optional HSIM)
CsRipEnetRpt Repeater Application (page 46)
Download Application (page 46)
Device Configuration View (page 47)
Port Configuration - CSIIfPort View (page 49)
FddiMAC Device Configuration View (page 49) 
(available with optional HSIM or FEPIM)

• ATM Client Configu
(available with opti

• Fast Ethernet Con
• Repeater Configura
• Ethernet Based Co

58)(available for GP
• Model Information
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Check)
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Tasks

This section identifies various management and troubleshooting tasks that can be per
SmartSwitch 6000 using the views, icons, and labels referenced within this document.

vertised Ability (Check)
Advertised Ability (page 55)

arm Thresholds (Set)
Model Information View (page 60)
Alarm Configuration (page 57)

plications (Change)
Application Label (page 24)

M Operation (Check)
ATM Client Configuration View (page 52)
ATM Client Application (page 41)

ckplane Connections (Monitor)
Backplane Device View (page 32)
Backplane Module Icon (page 34)

idging Information (View)
Application Label (page 24)

Chassis Information (
• Chassis Device Vie

Concentrator Status (
• FddiMAC Device C

Error Source (Selectio
• Error Source (page

Fast Ethernet Operati
• Fast Ethernet Con
• Fast Ethernet Appl
• Operational Mode (
• Advertised Ability (
• Received Technolog
• Ethernet Based Co

Fast Ethernet Operati
• Fast Ethernet Con
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e (Set)
age 25)

figuration View (page 54)
nfiguration (page 58)

(Check)
n (page 29)

ceived Tech (Check)
y (page 55)

Error Stats (View)
Error Breakdown View 

and Protocols (View)
ze & Protocols View (page 

e (Check)
 Subviews(Table 8)

(Check)
tion View (page 56)

eater Application (page 46)
s k s
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DI Operation (Check)
FddiMAC Device Configuration View (page 49)
The current operational mode of this port. 
FDDI MAC Application (page 41)

rmware (Upgrade)
Download Application (page 46)

odel a SmartSwitch 6000
Modeling (page 61)
Modeling Using the Chassis IP (page 63)
Positioning the Chassis Device Icon (page 66)

rformance Statistics (View)
Performance Views (page 18)

rt Operation (Monitor)
Chassis Module Icon (page 22)
Interface Labels (page 25)
Interface Device View (page 30)
Interface Icon (page 31)
Administrative Status Label (page 31)
Backplane Module Icon (page 34)
Device Configuration View (page 47)
Port Configuration - CSIIfPort View (page 49)

Port Operational Mod
• Interface Labels (p

Ports (Configure)
• Fast Ethernet Con
• Ethernet Based Co

Power Supply Status
• Chassis Informatio

Remote Hardware Re
• Received Technolog

Repeater Frame and
• Repeater Frame & 

(page 27)

Repeater Frame Size
• Repeater Frame Si

27)

Repeater Performanc
• Repeater Label Icon

Repeater Port Status
• Repeater Configura
• CsRipEnetRpt Rep

Download from Www.Somanuals.com. All Manuals Search And Download.



T a V i e w s S u m m a r y

S p S m a r t S w i t c h 6 0 0 0

Re
•

Re
•

To
•

Tr
•
•

Vi
•
•

s k s

e c t r u m E n t e r p r i s e M a n a g e r Page 17

peater Port Speed (Set)
Repeater Port Labels (page 28)

peater Port Condition Display (Change)
Repeater Port Display Form (page 27)

pology (Check)
Device Topology View (page 37)

aps (Set Up)
Device Configuration View (page 47)
Trap Configuration (page 57)

rtual Channel Operation (Check)
ATM Client Application VCL Table (page 42)
Virtual Channel Link View (page 44)
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Performance Views

This section provides brief descriptions of Performance views available for models of S
in SPECTRUM.

rformance views provide statistical information 
out the operation of the device and packet 
formation for the device and its ports. The 
lowing performance views are described in this 
ction:

Device Performance View (page 19)
Bridging Performance View (page 19)
Interface Performance View (page 19)
Repeater Port Performance View (page 20)

r more information on Performance views, refer 
 the Spectrum Views documentation.

Figure 3: Devic

*File View

IP address of type 6E132_25

Model Name

Contact

Description

Location

Net Addr

Prime-App

Log

100.0

10.00

1.00

0.10

0.01

0
00:40:0 0:30:0 0:20:0

%Receive Rtr

%FIltered

%Forwarded

%Trans Rate

Graph Proper
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mance View
ubviews menu of the Interface 
.

following information on 
packet transmission 
d statistics for the selected 
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evice Performance View
cess: From the Icon Subviews menu for the 
artSwitch 6000 Device icon, select Performance.

is view (Figure 3) provides the following current 
d historical frame transmission statistics for 
e device:

Received Rate‘
% Filtered
% Forwarded
Transmitted Rate

ridging Performance View
cess: From the Application label of the Chassis 
dule icon, select Bridge Performance.

is view provides the following information on 
rrent and historical frame rate statistics for the 
idging application:

Received Rate
% Filtered
% Forwarded
Transmitted Rate

Interface Perfor
Access: From the Icon S
icon, select Performance

This view provides the 
current and historical 
statistics, and error loa
interface:

• % Transmitted
• % Discarded
• % Error
• % Host Bound
• In Packet Rate
• Out Packet Rate
• Total Packet Rate
• In Load
• Out Load
• Total Load
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epeater Port Performance
iew
cess: From the Chassis Module icon, select Repeater 
bel, Repeater Performance.

is view provides the following current, average, 
ak frame rate and error statistics for repeater 
rts on the 6E123-50, 6E133-49, 6H123-50, 
d 6H133-37 modules:

Load
Frame Rate
% Error
% Collisions
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assis Device View

Help

type 6C105 of Landscape x: Primary

Sys Up Time

Manufacturer

Device Type

Serial Number

Chassis Information
Power
Redundancy:

PS #1 Status:
PS #2 Status:

Chassis Fans:

Chassis Module Icon

Redundant

Normal
Normal

Normal

Chassis Information
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Device Views

This section describes the Device views and subviews available for models of SmartS
SPECTRUM.

vice views use icons and labels to represent the 
odeled device and its components, such as 
odules, ports, and applications. There are four 
pes of Device views for the SmartSwitch 6000 
odels.

Chassis Device View (page 21)
Interface Device View (page 30)
Backplane Device View (page 32)
Physical Device View (page 36)

hassis Device View
is view contains icons that represent the 
rious physical modules installed within the 
assis of the modeled devices. It also contains a 
assis Information panel that shows chassis 
wer information. Figure 4 is an example of the 
w with a device installed in Slot 4 of the 
assis. The Chassis Module icon is described 
der Chassis Module Icon (page 22). The 
assis Information panel is described under 
assis Information (page 29).

Figure 4: Ch

*File V iew

6C105 of

Model Name

Contact

Description

Location

Net Addr

6E132-25

Model Name

e1

4

FWD

e2 FWD

e3 FWD

e4 FWD

e5 FWD

e6 FWD

e7 FWD

e8 FWD

e9 FWD

e10 FWD

e11 FWD

e12 FWD

e13 FWD

e14 FWD

e15 FWD

e16 FWD

e17 FWD

e18 FWD

e19 FWD

e20 FWD

e21 FWD

e22 FWD

e23 FWD

e24 FWD

Bridging
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4

6E132-25

Model Name

e1 FWD

e2 FWD

e3 FWD

e4 FWD

e5 FWD

e6 FWD

Bridging

tion View

uration View

ew
els

ance View

bel

abel

ubviews)

E2 UNLOCK

NLK12

ion View

nce View

rt Notes View

bviews
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hassis Module Icon
is icon is a logical representation of the 
ysical module, its location in the chassis, its 
nt panel interfaces and ports. 

gure 5 shows an example of a Chassis Module 
n. The callouts displayed in the illustration 

entify the labels and, when applicable, the view 
 which they provide double-click access.

e following pages describe the information 
ailable from the Chassis Module icon:

Module Identification Labels (page 23)
Application Label (page 24)
Interface Labels (page 25)
Module Icon Subviews (page 23)
Repeater Labels (page 26)
Repeater Port Labels (page 28)

Figure 5: Ch

Model Type/Model Informa

Model Name/Device Config

Slot Number/Application Vi
Module Identification Lab

Application Label/Perform

Interface Type La

Interface Status L

(Accesses Bridging Icon S

Interface Labels

Repeater Labels

Repeater Port Labels

Repeater Index/Configurat

Repeater Status/Performa

Repeater Port Number/Po
Repeater Port Status

Chassis Module Icon Su
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n Subviews Menu Options

Opens the...

Topology view described in 
RUM Views.

ations View (page 38).

 Configuration View (page 47).

Information view described in 
RUM Views.

ce Device View (page 30).

tion selection dialog box, 
allows you to select the 
tion to be displayed in the 
tion label. Example: Bridging.

Alarms view described in the 
RUM Portable Management 
ation for the SmartSwitch 
ser’s Guide.
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odule Identification Labels
ese labels provide the information described 
low (see Figure 5).

t Number
e module’s location in the chassis. Double-click 
is label to open the Application view described 
der Applications View (page 38).

del Type
e type of module in this chassis slot (e.g., 
132-25). Double-click this label to open the 

odel Information view described in the 
ECTRUM Views.

del Name
e user-defined or default (IP address) model 
me. Double-click this label to open the Device 
nfiguration View (page 47). 

odule Icon Subviews
ble 4 describes each of the device-specific Icon 
bviews menu selections available for the 
artSwitch 6000 modules.

Table 4: Module Ico

Menu
Selection

DevTop Device 
SPECT

Application  Applic

Configuration  Device

Model 
Information

Model 
SPECT

Interface  Interfa

Application 
Display

Applica
which 
applica
Applica

Basic Alarms  Basic 
SPECT
Applic
6000 U
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pplication Icon Subviews

Opens the...

Performance view described 
TRUM Views.

Detail view described in 
g Applications.

nformation view described in 
RUM Views.

runking Configuration and 
screen described in SPMA 

ng Tree Information view 
ed in Bridging Applications.

atabase Table view described 
ging Applications.

arent Bridge Information view 
rwarding Database and Port 
escribed in Bridging 
tions.
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pplication Label
is label displays the application currently 
lected, which is either Bridging, 802.1Q, or 
ysical. Bridging is the default application. To 
ange the application, highlight the Chassis 
odule icon and select View > Icon Subviews > 
plication Display.

uble-click the Application label to open the 
rformance view, which is described in 
ECTRUM Views.

e Application label provides access to the Icon 
bviews menu. Table 5 describes the Bridging 
plication Icon Subviews menu selections. There 
e no specific Icon Subviews menu selections for 
e Physical Application.

Table 5: Bridging A

Option

Bridge 
Performance

Bridge 
in SPEC

Bridge Detail Bridge 
Bridgin

Bridge Model 
Information

Model I
SPECT

Smart 
Trunking

SmartT
Status 
views.

Spanning Tree 
Information

Spanni
describ

Static Database 
Table

Static D
in Brid

Transparent 
Bridge 
Information

Transp
with Fo
tables d
Applica
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 Application Interface 
tatus

plication Interface Status

Description

ge port is forwarding.

 is disabled.

ge is in the listening mode.

ge is in the learning mode.

ge port is in the standby 
e.

ge port is in the blocking 
e.

ge port is broken.

 status is unknown.

Description

 is operational.

 is off.

 is in the test mode.
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terface Labels
ese labels represent the interfaces located on 
e front panel of the module. Each label provides 
cess to an Icon Subviews menu, which contains 
e following three device-specific selections:

Operational Mode Configuration allows you 
to set the interfaces operational mode to 
either Standard or Full Duplex.
Enable and Disable allow you to control the 
port’s operational status.

ch Interface label displays two information 
els: an Interface Type label and an Interface 

atus label.

erface Type Label
is label identifies the type and number of the 

terfaces represented. For example, “e1” refers to 
hernet interface number one for that module. 

erface Status Label
is label indicates the interface’s operational 
tus relative to the application using the colors 
d legends listed in Table 6 and Table 7. See 
plication Label (page 24) for information on 
lecting the application to be displayed.

Table 6: Bridging
S

Table 7: Physical Ap

Color Status

Green FWD Brid

Blue DIS Port

Magenta LST Brid

Magenta LRN Brid

Blue SBY Brid
mod

Orange BLK Brid
mod

Red BRK Brid

Blue UNK The

Color Status

Green ON Port

Blue OFF Port

Yellow TST Port
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perational status and 
ccess to the Performance 
d in SPECTRUM Views.

o provide access to the 
sted in Table 8.

abel Icon Subviews Menu 

Opens the...

ance view described in 
RUM Views.

er Frame & Error Breakdown 
age 27).

er Frame Size & Protocols View 
7).

er Configuration View (page 

 Information view described in 
RUM Views.

er Port Display Form (page 27), 
lets you select the type of 
displayed.
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epeater Labels
e 6E123-50, 6E133-49, 6H123-50, and 6H133-
 modules have repeater ports. The repeater 
rts on the 6E123-50 and 6E133-49 have a fixed 
rt speed of 10Mb while those on the 6H123-50 
d 6H133-37 can be switched between 10 Mb 
d 100 Mb. The repeater application 
sRipEnetRptr) is used for 10 Mb and 100 Mb 
pport on all of these modules, see the 
RipEnetRpt Repeater Application (page 46).

e Chassis Module Icon provides repeater 
anagement via the Repeater labels, which 
splay repeater status and provide access to 
ws that display performance, configuration, 
d frame statistics information.

e Repeater labels also let you control what type 
status is displayed on the Repeater Port labels 
ministrative, link, or speed status), see 
peater Port Display Form (page 27). The 
peater Port Labels (page 28) let you set the 
peater port speed. The Repeater labels contain 
e following labels.

peater Index
entifies the repeater and provides double-click 
cess to the Repeater Configuration View (page 
).

Repeater Status
Displays the repeater o
provides double-click a
View, which is describe

The Repeater labels als
Icon Subviews menu li

Table 8: Repeater L

Menu
Selection

Repeater 
Performance

Perform
SPECT

Repeater Frame 
& Error 
Breakdown

Repeat
View (p

Repeater Frame 
Size & Protocols

Repeat
(page 2

Repeater 
Configuration

Repeat
56).

Repeater Model 
Information

 Model
SPECT

Repeater Port 
Display Form

Repeat
which 
status 
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he values will continue to 
r is selected or another 
 selected. 

n the individual error 
Manage Your Network 

ize & Protocols View
atistical breakdown of 
ols for a selected repeater 
d protocol breakdowns are 
f pie charts and tables (as 
 Repeater Frame & Error 

lay Form
eater label Icon Subviews 
hoices: Admin, Link, and 
etermine which 
s displayed on the 
rt labels. For example, if 

tal, Delta, or Accum affects 
l as well as graphical 
n of every item contributing 
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epeater Frame & Error Breakdown
ew
is view displays frame and error statistical 

formation for a selected repeater port. The 
tistics are displayed in the form of pie charts 
d tables.

e Frame Breakdown displays the numerical 
d statistical breakdown of all the frames 
nsmitted and received through the selected 

peater. 

e Error Breakdown displays the number of 
ffic errors in an error-per-second format. 

e buttons at the bottom of the view affect how 
e statistics are represented in the pie charts 
d tables, as described below.

tal
splays the current statistical information for all 
ms contributing to the total value.

lta
splays the difference between the previously 
lled values and the current value of every item 
ntributing to the total.

cum
splays the accumulated statistical information 
 all items since the Accum button was last 
lected.

Clear
Restarts the counter. T
accumulate until Clea
representation mode is

For more information o
types, refer to How to 
with SPECTRUM.

Repeater Frame S
This view displays a st
frame sizes and protoc
port. The frame size an
displayed in the form o
described above for the
Breakdown view).

Repeater Port Disp
This option on the Rep
menu provides three c
Speed. These choices d
operational condition i
associated Repeater Po

Note:Note:

Selecting To
the numerica
representatio
to the total.
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ort Label Icon Subviews

er identifying a particular 

ity status.

e & Error Breakdown view 
e Size & Protocols view 

 tables that are similar to 
e Repeater Frame & Error 

 27) and the Repeater 
 View (page 27).

Description

a note pad for your use.

the Repeater Port Frame & 
reakdown view.

the Repeater Port Frame Size & 
ls view.

a dialog box that lets you 
or disable the port.

a dialog box that lets you set 
t speed to Auto, 10 Mbps, or 
ps.
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u select Admin via the E1 Repeater label, the 
peater Port labels associated with E1 (i.e., Ports 
through 12) will display the administrative 
tus.

epeater Port Labels
e 6E123-50 and 6E133-49 modules have 10 

b repeater ports while the 6H123-50 and 
133-37 modules have the capability of 
itching ports between 10 Mb and 100 Mb 

peaters. For example, a 6H133_37 model would 
ve three 100 Mb repeater models, but 
pending on the configuration, it might have six 
peater models, three at 10 Mb and three at 100 
b. The CsRipEnetRptr application is used for all 
ese modules for either 10 Mb or 100 Mb 
pport. 

e Chassis Module Icon provides Repeater Port 
els, which allow you to perform repeater port 

anagement. The views accessible from the 
peater Port label Icon Subviews menu are listed 
 Table 9.

Table 9: Repeater P

Repeater Port Number
Shows an index numb
repeater port.

Repeater Port Status
Indicates the port activ

The Repeater Port Fram
and Repeater Port Fram
provide pie charts and
what is described for th
Breakdown View (page
Frame Size & Protocols

Menu
Selection

Port Notes Opens 

Port Frame & 
and Error 
Breakdown

Opens 
Error B

Port Frame Size 
& Protocols

Opens 
Protoco

Enable/Disable 
Port

Opens 
enable 

Set Port Speed Opens 
the por
100 Mb
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hassis Information
is area of the Chassis Device view provides 

formation for the chassis power modules and 
oling fans. Figure 6 shows the Chassis 
formation fields as displayed in the Chassis 
vice view.

Figure 6: Chassis Information

wer Redundancy
splays the source of power for the chassis. 
edundant” indicates that power from the 
condary source is being used for the chassis. 
ON-Redundant” indicates that power from the 
imary power source is being used.

PS #1 Status
Displays the current st

PS #2 Status
Displays the current st

Chassis Fans
Displays the operation

Table 10 lists the poss
indication for the powe
fans.

Table 10: Chass
Def

Chassis Information

Power
Redundancy

PS #1 Status:

PS #2 Status:

Chassis Fans:

Redundant

Normal

Normal

Normal

Color

Green Norma

Gray Not ins

Red Not ope

Blue Unknow
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Help

22_26 of Landscape x: Primary

Network Information ADDRESS

System Up Time

Manufacturer

Device Type

Serial Number

RNET
7:2F:3C

ETHERNET
0:01D:17:2F:3C

0

ON b5 OFF

RNET
7:2F:3C

ETHERNET
0:01D:17:2F:3C

0

ON b1 OFF

RNET
7:2F:3C

OFF

RNET
7:2F:3C

OFF
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terface Device View
cess: From the Icon Subviews menu of the 
artSwitch 6000, select Device > Interface.

is view (Figure 7) provides dynamic 
nfiguration and performance information for 
ch of the device’s serial/network I/O ports, 
ich are represented by Interface icon in the 
ttom panel of the view, as shown in Figure 8. 
e middle panel of the view also displays a 
vice icon, which allows you to monitor the 
vice operation and access other device-specific 
ws.

Figure 7: Inte

* File V iew

IP Address on type 6E1

Filter

Interface Description

Physical

Model Name

Contact

Description

Location

Network Address

Primary-Application

Model Name

6E122_26

ETHE
0:01D:1

0

ETHERNET
0:01D:17:2F:3C

0

e1
ETHERNET
0:01D:17:2F:3C

0

ON e5 ON e9

ETHE
0:01D:1

0

ETHERNET
0:01D:17:2F:3C

0

e2
ETHERNET
0:01D:17:2F:3C

0

ON e6 ON e10

ETHE
0:01D:1

0

ETHERNET
0:01D:17:2F:3C

0

e4
ETHERNET
0:01D:17:2F:3C

0

ON e8 ON b4

ETHE
0:01D:1

0

ETHERNET
0:01D:17:2F:3C

0

e3
EHERNET

0:01D:17:2F:3C

0

ON e7 ON b2

10
1
.1
.01
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s interface (”e” indicates an 
 indicates a backplane 
eral represents the 
is module). 

 type of network interface 
, FDDI, etc.).

h of the Icon Subviews 
ble for the Interface icon.

el
 state of this port (On, Off, 
 Table 13 list the possible 
plication selected. The 

rface Icon Subviews

Opens the...

onfiguration - CSIIfPort View 
49).

 that provides the secondary 
ss and mask for the interface.

lient Application (page 41).

l Information view described in 
TRUM Views.
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terface Icon
is icon is a logical representation of a network 

terface or port, see Interface Device View (page 
). Figure 8 shows a sample Interface icon, its 
els and double-click zones. 

Figure 8: Network Interface Module Icon

Interface Number Label
This label identifies thi
Ethernet interface, “b”
interface, and the num
interface number on th

Interface Type Label
This label displays the
module (e.g., Ethernet

Interface Icon Subviews
Table 11 describes eac
menu selections availa

Administrative Status Lab
This label displays the
Testing). Table 12 and
states relative to the ap

(c)

(d)

(e)

(f)

(a) (b)

e1
Ethernet

0:0:1D:17:2F:3C

0

Interface Icon Subviews Menu

(a) Interface Number Label
(b) Status Label/Port Configuration
(c) Interface Type Label
(d) MAC Address Label/Model Information
(e) Network Information Label/Secondary Address Panel
(f) Gauge Label/Port Performance

ON
Table 11: Inte

Menu Selection

Configuration  Port C
(page 

Secondary 
Address Panel

Panel
addre

Protocols
(with HSIM only)

ATM C

Model 
Information

 Mode
SPEC
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rative Status

 performance statistic that 
ontrol Panel, which is 
erface Options panel. 
 to access the Performance 
on seethe information in 
 documentation. 

ice View
is Device view, select View > 

evice view is shown in 
tains Backplane Module 
e backplane connections 

G

B

Ye

Description

ge port is forwarding

 is disabled

ge is in listening mode

ge is in learning mode

ge port is in blocking mode

ge port is broken
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fault application for this view is Physical (MIB-
. To select the application to be displayed 
hysical or Bridging), click the Filter menu 
tton in the Interface Options panel. This label 
ovides double-click access to Port Configuration 
SIIfPort View (page 49).

C Address Label
is label displays the physical address of the 
twork interface module and accesses the CSI 
rt Model Information view described in 
ECTRUM Views.

twork Information Label
is label displays the network address, name, or 
bnet mask, which you select using the 
terface Options panel. The default is network 
dress. Double-click this label to access the 
condary Address Panel described in 
ECTRUM Views.

Table 12: Physical Application 
Administrative Status

Table 13: Br
Administ

Gauge Label
This label displays the
you set in the Gauge C
accessible from the Int
Double-click this label
view. For me informati
the SPECTRUM Views

Backplane Dev
Access: From the Chass
Page > Back plane.

A sample Backplane D
Figure 9. The view con
icons that represent th

Color Status Description

reen ON Port is operational

lue OFF Port is off

llow TST Port is in the test mode

Color Status

Green FWD Brid

Blue DIS Port

Magenta LST Brid

Magenta LRN Brid

Orange BLK Brid

Red BRK Brid
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for
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kplane Device View

Help

105 of Landscape x: Primary

ddr Sys Up Time

Manufacturer

Device Type

Serial Number

Chassis Information
Power
Redundancy:

PS #1 Status:
PS #2 Status:

Chassis Fans:

Backplane Module Icon

Chassis Information

Redundant

Normal
Normal

Normal
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 each of the modules installed in the chassis, 
e, Backplane Module Icon (page 34).

e Backplane Device view also contains a 
assis Information panel, which shows the 
me information as a similar panel on the 
assis Device view, see Chassis Information, 
assis Information (page 29). 

Figure 9: Bac

* File V iew

6C105 of type 6C

Model Name

Contact

Description

Location

Net A

6E132-25
Model Name

b1
b2
b3
b4
b5

4
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B
Fi
ico
vie
its
in

ule Icon

 device-specific Backplane 
 menu selections for the 

e Module Icon Subviews

Open the...

ice Topology view described in 
CTRUM Views.

plications View (page 38).

ice Configuration View (page 
.

del Information view described 
PECTRUM Views.

rface Device View (page 30).
v i c e V i e w s B a c k p l a n e
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ackplane Module Icon
gure 10 shows a sample Backplane Module 
n, which displays in the Backplane Device 
w. This icon represents the physical module, 
 location in the chassis, and its backplane 
terfaces.

Figure 10: Backplane Module Icon

Backplane Mod
Subviews
Table 14 describes the
Module Icon Subviews
module.

Table 14: Backplan

Slot Number/

Model Type/

Model Name/

6E132-25

b1

4

Model Name

b2

b4
b5

b3

Module Identification Labels

Application View

Model Information

Device Configuration

Backplane Connections Labels

Backplane Module
Icon Subviews

Option

DevTop Dev
SPE

Application  Ap

Configuration Dev
47)

Model Information Mo
in S

Interface Inte

Download from Www.Somanuals.com. All Manuals Search And Download.



D e M o d u l e I c o n S u b v i e w s

S p S m a r t S w i t c h 6 0 0 0

M
Th
th

Slo
Th
th
un

Mo
Th
6E
M

Fo
vie
do

Mo
A 
IP
De

B
Th
m
sp
lab
th
No

onnection label (b4), 
h interface four of the 

 possible operational states 
ctions.

ane Connection Status 
riptions

ion
n panel within the 
 provides the same 
r panel in the Chassis 

under Chassis Information 

Description

rational

rational but not linked

rational test

rationally and administratively 
n

rationally down but 
inistratively enabled

nown
v i c e V i e w s B a c k p l a n e
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odule Identification Labels
ese labels provide the following information 
at identifies a specific device.

t Number
e module’s location in the chassis. Double-click 
is area to open the Application view described 
der Applications View (page 38).

del Type
e type of module in the chassis (for example 
132-25). Double-click this area to open the 

odel Information view. 

r more information on the Model Information 
w, refer to the SPECTRUM Views 
cumentation.

del Name
user-defined name; otherwise, it defaults to the 
 address. Double-click this area to open the 
vice Configuration View (page 47).

ackplane Connections Labels
ese labels represent the interfaces between the 

odule and the FTM backplane. The device-
ecific Icon Subviews menu selection for these 
els is Configuration, which opens a dialog box 

at lets you enable or disable the selected port. 
te in Figure 15 that the Backplane Module icon 

has a gray Backplane C
which corresponds wit
chassis backplane.

Table 15 describes the
of the backplane conne

Table 15: Backpl
Desc

Chassis Informat
The Chassis Informatio
Backplane Device view
information as a simila
Device view described 
(page 29).

Color Status

Green ON Ope

Yellow NLK Ope

Magenta Test Ope

Blue Off Ope
dow

Red Off Ope
adm

Gray UNK Unk
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P
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ysical Device View

Help

5 of Landscape x: Primary

Sys Up Time

Manufacturer

Device Type

Serial Number

CaBLeTROn
SYSTeMS

6C105

Smart
SWITCH

6000

100 • 125 VAC
200 • 250 VAC

50 • 60 Hz

CaBLeTROn
SYSTeMS

PDK 0 0 REDUNDANCY

6C205-1

B0096520019SN

100 • 125 VAC
200 • 250 VAC

50 • 60 Hz

CaBLeTROn
SYSTeMS

PDK 0 0 REDUNDANCY

6C205-1

B0096520019SN

Smart
SWITCH

6000

1X
3X
5X
7X
9X
1X
3X
5X
7X
9X
1X
3X

6E132-25

ETHERNET

COM

CPU
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hysical Device View
is view provides a static image of the chassis 
d the modules installed in it. Figure 11 shows a 
mple Physical Device view with two power 
pplies and a module installed in Slot 4.

Figure 11: Ph

* File V iew

6C105 of type 6C10

Model Name

Contact

Description

Location

Net Addr

Smart
SWITCH

6000

Smart
SWITCH

6000

Smart
SWITCH

6000

1
1
1
1
1
2
2
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els of SmartSwitch 6000

Ac
Sm

De
co
ne
To
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ne

Fo
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vice Topology View

Help

6H203_24 of Landscape x: Primary

Model Type

Model Type

WD
NET
.A:BC

3 FWD
ETHERNET

0.0.2.1.0.5.1.A:BC

0

4 FWD
ETHERNET

0.0.2.1.0.5.1.A:BC

0

10
1
.1
.01
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Device Topology View

This section provides brief descriptions of the Device Topology views available for mod
devices in SPECTRUM.

cess: From the Icon Subviews menu for the 
artSwitch 600 Device icon, select DevTop

vice Topology views (Figure 12) show the 
nnections between a modeled device and other 
twork entities. The lower panel of the Device 
pology view for the SmartSwitch 6000, uses 
terface icons to represent the device’s 
rial/network I/O ports. These icons provide the 
me information and menu options as those in 
e Interface Device View (page 30). If there is a 
vice connected to a particular interface, a 
vice icon appears on the vertical bar above the 
terface icon along with an icon representing the 
twork group that contains the device.

r further information on Device Topology views, 
fer to the SPECTRUM Views documentation.

Figure 12: De

* File V iew

IP Address of type

1 FWD
ETHERNET

0.0.2.1.0.5.1.A:BC

0

2 F
ETHER

0.0.2.1.0.5.1

0

Model Type

Model Type

10
1
.1

.01
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bviews available for

Ac
Sm

W
au
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de
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Fi
de
m
Fi
ar
wi
re
be

If 
na
M

Application View

Help

25 of Landscape VNM: Primary

Sys Up Time

Manufacturer

Device Type

Serial Number

Model Name

6E132_25
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Applications View

This section describes the Application view and the associated application-specific su
models of SmartSwitch 6000 devices in SPECTRUM.

cess: From the Icon Subviews menu for the 
artSwitch 6000 Device icon, select Application.

hen a device model is created, SPECTRUM 
tomatically creates a model for each of the 
ajor and minor applications supported by the 
vice. The Application view identifies all of these 
plication models, shows current condition 
tus, and provides access to application-specific 
bviews. 

gure 13 shows and Application view in its 
fault mode(Icon) where each of the application 
odels is represented by an Application icon (see 
gure 14 for a close-up). The Application icons 
e arranged hierarchically under a Device icon, 
th major applications in the top row and their 
spective minor applications stacked directly 
low.

you prefer to see applications displayed by 
me only in a single vertical list, select View > 
ode > List.

Figure 13:  

* File V iew

IP Address of type 6E132_

Model

Contact

Description

Location

Net Addr

Prime-App

Download from Www.Somanuals.com. All Manuals Search And Download.



A p

S p S m a r t S w i t c h 6 0 0 0

A
W
of 
Ap
M
th
In
ap
bo
wh
vie
ar
Ic

Application Icon

odel Information View
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pplication Specific View

IP2_App

modelname_IP

IP2_App
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pplication Icons
hen the Application view is in Icon mode, each 
the application models is represented by an 
plication icon (Figure 14). Double-clicking the 

odel Name label (a) at the top of the icon opens 
e associated Model Information view-Model 
formation View (page 60). For some 
plications, the Model Type label (c) at the 
ttom of the icon is also a double-click zone, 
ich opens an application-specific view. Any 
ws accessible through these double-click zones 
e also accessible from the Application icon’s 
on Subviews menu.

Figure 14:

a Model Name Label/ M

b Condition Status Lab

c Model Type Label / A

(a)

(b)

(c)
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S
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•
•

•

•

pplication View
ubviews menu for the 
st Ethernet or Double-click 

ess to the Model 
ribed in SPECTRUM 
hernet Port Table 

rt Table
t Ethernet Application 
rmation described below, 
ss to the Fast Ethernet 
ge 54) when you double-
able. The Fast Ethernet 

mon Applications

For more info, see...

idging Application

IB II Applications

andard RMON
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upported Applications
artSwitch 6000 devices support both common 

d device-specific application.

plications that are common to many of the 
fferent of kinds of and makes of devices are 
ted in Table 16 along with their corresponding 
cumentation. 

e views and subviews available for the 
artSwitch 6000 device-specific applications 

e described in the rest of this section, grouped 
 major application listed below:

Fast Ethernet Application View (page 40)
The current operational mode of this port. 
FDDI MAC Application (page 41) (available 
with optional HSIM)
ATM Client Application (page 41) (available 
with optional HSIM)
CsRipEnetRpt Repeater Application (page 46)
Download Application (page 46)

Fast Ethernet A
Access: From the Icon S
Application icon, select Fa
the Application icon.

This view provides acc
Information view (desc
Views) and the Fast Et
described below.

Fast Ethernet Po
This section of the Fas
views provides the info
and also provides acce
Configuration View (pa
click any entry in the t

Table 16: Com

Application

Bridging 
(CSIBridge)

Br

MIB-II 
(SNMP2_Agent)

M

Standard RMON St
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Co
Gr

Int
Th
Fa

Po
Th
Et

Po
Th
Et

Op
Th
M

Th
Ap
th

Ta
av
FD

lication
d to monitor and control 
TM Client Application VCL 
 Table 18 lists the 
bviews available for the 

M

D

 the FDDI Station List view 
bed in Miscellaneous 
ations.

 you to acknowledge an alarm 
ion.

 the Device Configuration View 
47).

 the Model Information view 
bed in SPECTRUM Views.
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nfiguration view carries the Interface, Port 
oup, and Port information over from this table.

erface
e interface number of the port for which this 
st Ethernet information pertains. 

rt Group
e port group number for which this Fast 
hernet information pertains.

rt
e physical port number for which this Fast 
hernet information pertains.

erational Mode
e current operational mode of this port. FDDI 

AC Application

is section describes the FDDI MAC (FddiMAC) 
plication, which is available for modules having 
e optional HSIM installed.

ble 17 lists the application-specific subviews 
ailable from the Icon Subviews menu for the 
DI MAC application.

Table 17: FDDI MAC Icon Subviews

ATM Client App
This application is use
ATM channels via the A
Table described below.
application-specific su
application.

enu Selection Description

evTop Opens the Device Topology view 
described in SPECTRUM Views.

Station List Opens
descri
Applic

Acknowledge Allows
condit

Configuration Opens
(page 

Model 
Information

Opens
descri
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AT
Ad
Im
VC
VC
de
wh

Op
In
VC
is 
sta

e at the time this VCL 
rational state. If the 
red prior to the last re-
nt, then this field contains 

cription) Index
dentifies the row in the 
 Table that applies to the 
 VCL.

scription) Index
dentifies the row of the 
 Table that applies to the 
is VCL.

yer) Type
 only exists when the local 
e VCC endpoint and AAL 
cates the type of AAL used 
ludes AAL1, AAL3/4, and 

 is a user-defined AAL type. 
dicates that the AAL type 

 only exists when the local 
e VCC endpoint and AAL5 
cates the maximum AAL5 

C

M
In

V

In
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Table 18: ATM Client Application Icon 
Subviews

M Client Application VCL Table
min Status
plemented only for a VCL that terminates a 
C (i.e., one that is not cross-connected to other 
Ls). Its value (“Up” or “Down”) specifies the 
sired administrative state of the VCL, i.e., 
ether traffic flow is enabled or disabled.

er Status
dicates the current operational status of the 
L. “Up” and “Down” indicate whether the VCL 
operational. “Unknown” indicates that the 
tus of this VCL cannot be determined.

Last Change
The value of sysUpTim
entered its current ope
current state was ente
initialization of the age
a zero value.

RTD (Receive Traffic Des
The value of this field i
ATM Traffic Descriptor
receive direction of this

TTD (Transmit Traffic De
The value of this field i
ATM Traffic Descriptor
transmit direction of th

AAL (ATM Adaptation La
An instance of this field
VCL endpoint is also th
is in use. The field indi
on this VCC, which inc
AAL5. The “other” type
The “unknown” type in
cannot be determined.

Transmit Size
An instance of this field
VCL endpoint is also th
is in use. The field indi

Option Opens the...

onfiguration  Device Configuration View (page 47).

odel 
formation

 the Model Information view described in 
SPECTRUM Views.

CL Table  ATM Client Application VCL Table 
described below.

terfaces Port Configuration - CSIIfPort View (page 
49) and the CSIIfPort Performance view 
described in SPECTRUM Views.
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CP
tra

Re
Th
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in
oc
th

En
An
VC
is 
en
(R
En
Fo

VC
Th
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sa
sa
co
Co
va
as
ha

ate, delete, or modify a row 
 a new VCL, this field is 
ndWait” or “createAndGo.” 
set to “active” unless the 
ds exist in this row: 

al VCL endpoint is also the 

AAL5 connections only)
L5 connections only)

AL5 connections only)

e rows in the table view, 

tion Information panel, 
nity Name field to 

views menu, select Table 

ity Name field in the 
ion Information panel of the 
ation view must be set to 
rder to change the fields in 
s.
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e c t r u m E n t e r p r i s e M a n a g e r Page 43

CS SDU size in octets that is supported on the 
nsmit direction of this VCC.

ceive Size
is field is used when the local VCL endpoint is 
o the VCC endpoint and AAL5 is used. It 

dicates the maximum AAL5 CPCS SDU size in 
tets that is supported on the receive direction of 
is VCC.

caps Type
 instance of this field only exists when the local 
L endpoint is also the VCC endpoint and AAL5 
in use. The field indicates the type of data 
capsulation used over the AAL5 SSCS layer. 
eference RFC 1483, Multiprotocol 
capsulation over ATM AAL5, and the ATM 
rum LAN Emulation specification.)

L CC (Cross Connect) Id
is field is implemented only for a VCL that is 
oss-connected to other VCLs that belong to the 
me VCC. All such associated VCLs have the 
me value as this field, and all their cross-
nnections are identified by entries in the Cross 
nnect Table for which VCL CC Id has the same 
lue. The value of this field is initialized after the 
sociated entries in the Cross Connect Table 
ve been created.

Row Status
This field is used to cre
in this table. To create
initially set to “createA
This field must not be 
following columnar fiel

• RTD Index
• XTD Index
• AAL Type (if the loc

VCC endpoint)
• Transmit Size (for 
• Receive Size (for AA
• Encaps Type (for A

To make a change to th
do the following:

1 In the Communica
change the Commu
“private.”

2 From the Icon Sub
View.

Note:Note:

The Commun
Communicat
Model Inform
“private” in o
the table view
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3

4

5

6

7

Th

Do
sp
Lin

V
Ac
Ap

Int
Di

VP
Di
VP
th

tifier)
 of the VCL. The maximum 
d the value allowable by 
its.

 VCL that terminates a 
ot cross-connected to other 
Down) specifies the desired 
 the VCL, i.e., whether 
nd disabled for this VCL.

perational status of the 
 indicate that the VCL is 
ational, respectively. 
t the status of this VCL 

r modify a row in this 
VCL, this field is initially 
 or “createAndGo”. This 
 “active” unless the 
ds exist in this row: 

al VCL endpoint is also the 

AAL5 connections only)
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Set the path information for the row you wish 
to create, change, or remove.

Press Return and click OK.

To create or change a row, click the Create 
button, change the applicable fields in the 
Change view and click the right mouse 
button. Click OK.

Click the Validate Row button and return to 
the application table view to see the change.

To remove a row, highlight it, click the 
Remove button, and then the Update button.

e row will then be removed from the table view.

uble-clicking a field entry opens the interface-
ecific ATM Switch Application Virtual Channel 
k view, which is described below.

irtual Channel Link View
cess: From the Icon Subviews of the ATM 
plication icon, select Virtual Channel Link.

erface
splays the interface index for this VPI and VCI.

I (Virtual Path Identifier)
splays the VPI value of the VCL. The maximum 
I value cannot exceed the value allowable by 
e Interface MaxVPI Bits.

VCI (Virtual Channel Iden
Displays the VCI value
VCI value cannot excee
the Interface MaxVCI B

Admin Status
Implemented only for a
VCC (i.e., one that is n
VCLs). Its value (Up or 
administrative state of
traffic flow is enabled a

Oper Status
Indicates the current o
VCL. “Up” and “Down”
operational or not oper
Unknown indicates tha
cannot be determined.

Row Status
Used to create, delete o
table. To create a new 
set to “createAndWait”
field must not be set to
following columnar fiel

• RTD Index
• XTD Index
• AAL Type (if the loc

VCC endpoint)
• Transmit Size (for 
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On
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Th
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Cr
Im
co
VC
va

s in the Cross Connect 
C Id has the same value. 
s initialized by the agent 
tries in the Cross Connect 
d.

e ATM Traffic Descriptor 
e transmit direction of this 

cal VCL endpoint is also 
 AAL5 is in use. The 
 SDU size in octets that is 
mit direction of this VCC.

e ATM Traffic Descriptor 
e receive direction of this 

cal VCL endpoint is also 
 AAL5 is in use. The 
 SDU size in octets that is 
ve direction of this VCC.
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Receive Size (for AAL5 connections only)
Encaps Type (for AAL5 connections only)

caps Type
ly exists when the local VCL endpoint is also 

e VCC endpoint, and AAL5 is in use. The field 
dicates the type of data encapsulation used over 
e AAL5 SSCS layer. (Reference RFC 1483 
ultiprotocol Encapsulation over ATM AAL5 and 
e ATM Forum LAN Emulation specification.)

L (ATM Adaptation Layer) Type
ly exists when the local VCL endpoint is also 

e VCC endpoint, and AAL is in use. The field 
dicates the type of AAL used on this VCC, which 
cludes AAL1, AAL3/4, and AAL5. The value 
ther” is a user-defined AAL type. “Unknown” 
dicates that the AAL type cannot be determined.

st Change
e value of “sysUpTime” at the time this VCL 
tered its current operational state. If the 
rrent state was entered prior to the last re-
itialization of the agent, then this field contains 
ero value.

oss Connect Id
plemented only for a VCL that is cross-
nnected to other VCLs that belong to the same 
C. All such associated VCLs have the same 

lue of this field, and all their cross-connections 

are identified by entrie
Table for which VCL C
The value of this field i
after the associated en
Table have been create

Xmit Descr Index
Identifies the row of th
Table that applies to th
VCL.

Transmit Size
Only exists when the lo
the VCC endpoint, and
maximum AAL5 CPCS
supported on the trans

Rcv Descr Index
Identifies the row in th
Table that applies to th
VCL.

Receive Size
Only exists when the lo
the VCC endpoint, and
maximum AAL5 CPCS
supported on the recei
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del type for this 
oadApp. 
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sRipEnetRpt Repeater
pplication
cess: Double-click the CsRipEnetRpt Repeater 
plication icon.

e CsRipEnetRpt supports the 6H123_50, 
133_49, 6H123_50, and 6H133_37 model 

pes. 

ble 19 lists all the application-specific subviews 
ailable from the Icon subviews menu for this 
plication.

Download Appl
This application provid
for the module. The mo
application is CtDownL

The Download Applica
and is described in SP
Management Applic

Table 19: CsRipEnetRpt Application Icon 
Subviews

Menu
Selection

Open the...

evTop Device Topology view described in 
SPECTRUM Views.

onfiguration  Repeater Configuration View (page 56).

formation Repeater Model Information view described 
in SPECTRUM Views.
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Co
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•
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•

•

•
•
•

e Configuration View 

ration View
ubviews menu the 
 icon, select Configuration.

Help
Landscape VNMHost: Primary

Sys Up Time
Manufacturer
Device Type
Serial Number

No. Interfaces

figuration View

hy Address Max Frame Size Oper Status

terface Configuration Table

umber of Interfaces
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Configuration Views

This section describes the various Configuration views and subviews available for mod
devices in SPECTRUM.

nfiguration views (Figure 15) allow you to view 
d modify current setting for the modeled device 
d its interfaces, ports, and applications. The 
lowing Configuration views are available for 
odels of the SmartSwitch 6000:

Device Configuration View (page 47)
Port Configuration - CSIIfPort View (page 49)
FddiMAC Device Configuration View (page 49) 
(available with optional HSIM or FEPIM)
ATM Client Configuration View (page 52) 
(available with optional HSIM or FEPIM)
Fast Ethernet Configuration View (page 54)
Repeater Configuration View (page 56)
Ethernet Based Configuration (page 58)
(available with GPIM models)

Figure 15: Devic

Device Configu
Access: From the Icon S
SmartSwitch 6000 Device

*File V iew

IP Address of type 6E132_25 of

Model
Contact

Description
Location

Net Addr

Prime-App

Device Name Contact Status

Device Con

Index Type P

In

N
Print

Component Table

DownLoad Application

Trap Table
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Co
In
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Ac
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re
Ap

Ac
let
th
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Ma

t lets you set up your 
ied of traps received and 

ration Table
ice Configuration views 
information:

es available from the 

entifying the port.

nterface for the port.

e port.

ize for the module.

l state of the port (Up, 

Do
n f i g u r a t i o n V i e w s D e
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is view (Figure 15) provides status and 
nfiguration information about the device as a 
ole as well as on a port-by-port basis. Fields 
d Column heading with the Device 
nfiguration view and its subviews are explained 

 further detail in the SPECTRUM Views 
cumentation.

ntact Status
dicates whether a connection has been 
tablished with the module.

cesses the Community Name view. For 
formation on using the Community Name view, 
fer to SPECTRUM Portable Management 
plication Tools Guide.

cesses the TFTP DownLoad dialog box, which 
s you upgrade firmware for the module from 
e TFTP Boot or Bootp Server. For more 
formation, refer to SPECTRUM Portable 
nagement Application Tools Guide.

Opens a dialog box tha
workstation to be notif
sent by a module.

Interface Configu
This section of the Dev
provides the following 

Number of Interfaces
The number of interfac
module.

Index
The numerical value id

Type
The type of hardware i

Phy Address
The MAC address of th

Max Frame Size
The maximum frame s

Oper Status
The current operationa
Down, or Testing).

Component
Table

wnload Application

Trap
Table
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P
V
Ac
60

Th
in

Int
Th

Int
Th
FD

Op
Th
va

Ad
A 
ad
ar

IF
Al
in

e Configuration

ubviews menu for the Chassis 
I Configuration, from the 

the FddiMac Application icon, 

rmation on the 
ating status of the 
 is divided into two areas, 
and SMT Information. 

tion
AC Device Configuration 
ion specific to the FDDI 

e FDDI ring. Table 20 lists 
 their descriptions.

iguration of the station. 
le configuration states and 

on resides on. Possible 
condary, Local, or Isolated.
n f i g u r a t i o n V i e w s P o r t C o n f i g u
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ort Configuration - CSIIfPort
iew
cess: From the Icon Subviews of the SmartSwitch 
00 Interface Icon, select CSIifPort.

is view displays interface-specific MIB 
formation for the module. 

erface Index
e numerical value identifying the port.

erface Type
e type of interface for the port (e.g., Ethernet, 
DI, etc.).

eration Status
e current operating state of the port. Possible 
lues are On, Off, or Test.

min Status
button that lets you change the current 
ministrative status of the port. Possible values 
e On, Off, or Test.

Description
lows you to enter a textual description of the 
terface.

FddiMAC Devic
View
Access: From the Icon S
Device views, select FIDD
Icon Subviews menu of 
select Configuration.

This view provides info
configuration and oper
concentrator. The view
Station Configuration 

Station Configura
This area of the FddiM
view provides informat
station.

Ring State
The current state of th
the possible states and

MAC Configuration
Displays the actual conf
Table 21 lists the possib
their descriptions.

Current MAC Path
The ring that this stati
values are Primary, Se
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MA
Th

MA
Th

ster ports on this station.

 ports on this station.

Is

N

R

D ond. This indicates a potential 

N FDDI address has been 

R

D entrator is now sending 

T trace is being sent to notify the 
een the concentrator and its 
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C Address
e MAC (physical) address of this station.

C Count
e number of MACs supported by this station.

Non Master Ports
The number of non-ma

Master Ports
The number of master

Table 20: FDDI Ring Stats

Ring State Description

olated The concentrator is not attached to the ring.

on-Op The concentrator is attempting to enter the ring.

ing-Op The ring is operational.

etect The claim/beacon process of the FDDI ring protocol has exceeded one sec
problem.

on-Op-Dup The ring failed to complete the claim/beacon process because a duplicate 
detected.

ing-Op-Dup The ring is operational, but a duplicate FDDI address has been detected.

irected The claim/beacon process did not complete within nine seconds. The conc
directed beacons to indicate a problem.

race A problem has been detected with the station or its upstream neighbor. A 
upstream neighbor of the problem. The concentrator and all stations betw
upstream neighbor can perform self-tests.
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W

W

W d to the A port.

W

C pped to the A port. Regarding 
 path.

C pped to the B port. Regarding 
 path.

C pped to the S port. Regarding 
 path.

T ary path enters the B port and 
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Table 21: SMT MAC Configuration States

ing State Description

solated The port is not inserted into any path.

ocal_A The A port is inserted into a local path and the B port is not.

ocal_B The B port is inserted into a local path and the A port is not.

ocal_AB Both A and B ports are inserted into a local path.

ocal_S The S port is inserted into a local path.

rap_A The secondary path is wrapped to the A port.

rap_B The secondary path is wrapped to the B port.

rap_AB The primary path is wrapped to the B port and the secondary path is wrappe

rap_S The primary port is wrapped to the S port.

_Wrap_A The primary and secondary paths are joined internally in the station and wra
token flow, all resources on the secondary path precede those of the primary

_Wrap_B The primary and secondary paths are joined internally in the station and wra
token flow, all resources on the secondary path precede those of the primary

_Wrap_S The primary and secondary paths are joined internally in the station and wra
token flow, all resources on the secondary path precede those of the primary

hru The primary path enters the A port and emerges from the B port. The second
emerges from the A port.
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figuration View
/VPC configuration 

 interfaces.

onnections)
 of VPCs supported at this 
NI (User Network 

m number of VPCs ranges 

nel Connections)
 of VCCs supported at this 

onfigured for use at this 
NI (User Network 

ed number of VPCs ranges 

onfigured for use at this 

ntifier) Bits
 of active VPI bits 
is ATM interface. At the 
rface), the maximum 
its configured for use 
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MT Information
is area of the FddiMAC Device Configuration 
w provides the following configuration 

formation on the FDDI SMT:

T Version
e version of Station Management (SMT) 
nning.

S Present
dicates whether an Optical Bypass Switch 
BS) is connected.

otify (sec)
e timer value, in seconds, used in Neighbor 
tification Protocol. The allowed range is from 2 

 30 seconds.

eq (milli sec)
e Target Token Rotation Time (TTRT) bid, in 

illiseconds, made by this concentrator.

eg (milli sec)
e winning TTRT bid, in milliseconds, on the 
g.

X (milli sec)
e valid transmission time, in milliseconds.

ATM Client Con
This view provides VPI
information on the ATM

Max VPCs (Virtual Path C
The maximum number
ATM interface. At the U
Interface), the maximu
from 0 to 256.

Max VCCs (Virtual Chan
The maximum number
ATM interface.

Conf VPCs
The number of VPCs c
ATM interface. At the U
Interface), the configur
from 0 to 256.

Conf VCCs
The number of VCCs c
ATM interface.

Max VPI (Virtual Path Ide
The maximum number
configured for use at th
UNI (User Network Inte
number of active VPI b
ranges from 0 to 8.
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Th
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n send SNMP messages as 
ort 161 in order to access 
nformation concerning the 
m. 

ce on the neighbor system 
terface, and to which this 

he neighbor system is 
NMP and supports the 
e of this object must be 
ifName for the ifEntry of 
al interface for this port. If 
 have a name, the value of 
gth string.
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x VCI (Virtual Channel Identifier) Bits
e maximum number of active VCI bits 
nfigured for use at this ATM interface.

I (Interim Local Management Interface) VPI
e VPI value of the VCC supporting the ILMI at 
is ATM interface. If the values of both ILMI VPI 
d ILMI VCI equal 0, then the ILMI is not 
pported for this ATM interface.

I VCI
e VCI value of the VCC supporting the ILMI at 
is ATM interface. If the values of both ILMI VPI 
d ILMI VCI equal 0, then the ILMI is not 
pported for this ATM interface.

dress Type
e type of primary ATM address configured for 
e at this ATM interface.

min Address
e address assigned for administrative 
rposes. If this interface has no assigned 
ministrative address or if the address used for

ministrative purposes is the same as that used 
 the physical address, then this is an octet 
ing of zero length.

ighbor Address
e IP address of the neighbor system connected 

 the far end of this interface to which a Network 

Management Station ca
IP datagrams to UDP p
network management i
operation of that syste

Neighbor If Name
The name of the interfa
at the far end of this in
interface connects. If t
manageable through S
object ifName, the valu
identical to that of the 
the lowest level physic
this interface does not
this object is a zero len
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ernet Configuration View

e
 Ethernet Configuration 
t operational mode of this 
Negotiation , you can 
as needed from the 

Help

pe 6E122_26 of Landscape

Sys Up Time

Manufacturer

Device Type

Serial Numberlica-

04 SmartSwitch

132.127.118.24

Port

ional Mode

ity

ceived Technology

BaseTX

BaseTXFD

BaseT4

100BaseFX

100BaseFXFD

100BaseFXFD

FD
TX

100BaseTXFD
100BaseT4
100BaseFX

100BaseFXFD
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ast Ethernet Configuration
iew
cess: Double-Click any entry in the Fast Ethernet 
rt Table to open this view.

is view (Figure 16) lets you configure ports for 
hernet, Fast Ethernet, or Auto-Negotiation. The 
st Ethernet Configuration views contains three 
nels: Operational Mode, Advertised Ability and 
ceived Technology, that provide additional 
formation for configuring this device.

Figure 16: Fast Eth

Operational Mod
This panel, in the Fast
view, shows the curren
port. If you select Auto-
select as many modes 

File View

132.127.118.24 of ty

Model Name

Contact

Description

Location

Net Addr

Primary App

Cabletron 6E122_26 Rev 01.01.

Interface Port Group

Operat

Advertised Abil

Re

Auto-Negotiation

10BaseT

10BaseTFD

100

100

100

10BaseT

10BaseTFD

100BaseTX

100BaseTXFD

100BaseT4

100BaseFX

Undefined
Auto-Negotiation
Not-Detected

10BaseT
10BaseT
100Base
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Ad
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A
Th
vie
ha
th
ne
se
th

onfigure themselves for 
plex (standard mode) 
nds of the link support 
 only one link partner 
ion, the mode defaults to 
ists the advertised ability 
d descriptions.

rtised Ability Values

logy
 Ethernet Configuration 
d technology of the remote 
er. Table 24 lists the 
des, their values, and 
des are read only.

O

A

1

1

1

1

1

1

1

Description

10Base-T

Full Duplex 10Base-T

100Base-TX

Full Duplex 100Base-TX

100Base-T4

100Base-FX

Full Duplex 100Base-FX
n f i g u r a t i o n V i e w s F a s t E t h e r
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vertised Ability selections. You can only select 
e Operational Mode. Table 22 shows the 
rrent modes, their values, and descriptions.

Table 22: Operational Mode Values

dvertised Ability
is panel, in the Fast Ethernet Configuration 
w, shows the advertised ability of the local 
rdware, which only becomes active on ports 
at have Auto-Negotiation enabled. Auto-
gotiation allows the FE-100TX RJ45 port to 
lf-configure to 10 or 100 Mbps depending on 
e speed of the attached module. The interfaces 

can also dynamically c
Full Duplex or Half Du
operation when both e
auto-negotiation. When
supports auto-negotiat
half duplex. Table 23 l
modes, their values, an

Table 23: Adve

Received Techno
This panel, in the Fast
view, shows the receive
hardware, or link partn
received technology mo
descriptions. These mo

perational Mode Value Description

uto Negotiation 2 Auto Negotiation/Parallel 
Detect.

0Base-T 8 10Base-T

0Base-TFD 16 Full duplex 10Base-T

00Base-TX 32 100Base-TX

00Base-TXFD 64 Full duplex 100Base-TX

00Base-T4 128 100Base-T4

00Base-FX 256 100Base-FX

00Base-FXFD 512 Full Duplex 100Base-FX

Advertised
Ability Value

10Base-T 8

10Base-TFD 16

100Base-TX 32

100Base-TXFD 64

100Base-T4 128

100Base-FX 256

100Base-FXFD 512
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epeater interface. This view 
 areas described below 
t, Trap Management, 

 and Error Source).

ement
ter Configuration view 
mation described below.

ber of ports on this LAN 

ber of ports currently in 
twork.

f operational ports on this 

e network ports on this 
ible states are: “NoEnable” 

U

A
N

N

1

1

1

1

1

1

1
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Table 24: Received Technology Values

epeater Configuration View
cess: From the Chassis Device view highlight the 
propriate Repeater label on the Chassis Module icon, 
m Icon Subviews menu, the select the Repeater 
nfiguration.

e Repeater Configuration view provides 
formation on the configuration and operating 

status of the selected r
is divided into the four
(Repeater Managemen
Alarm Configuration,

Repeater Manag
This area of the Repea
provides the port infor

Port Count
Displays the total num
segment.

Ports On
Displays the total num
the ON state on this ne

Ports Operational
Displays the number o
network.

Network Ports
Allows you to enable th
network segment. Poss
and “Enable”.

Received
Technology Value Description

ndefined 1 Undefined

uto-
egotiation

2 Auto-Negotiation/Parallel 
Detection

ot-Detected 4 Link Partner does not support 
Auto-Negotiation

0Base-T 8 10Base-T

0Base-TFD 16 Full duplex 10Base-T

00Base-TX 32 100Base-TX

00Base-TXFD 64 Full duplex 100Base-TX

00Base-T4 128 100Base-T4

00Base-FX 256 100Base-FX 

00Base-FXFD 512 Full duplex 100Base-FX
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 disable detection of Traffic 

 value for the number of 
nsmitted during the 

ating a traffic alarm. This 
le from 1 to 4 billion.

r disable detection of 

 value within the alarm 
hat number of collisions 
eded, generates a collision 
er-configurable. Allowable 
ns per good packet.

r disable detection of 

 value within the alarm 
hat number of broadcasts 
enerates a broadcast 
er-configurable. Allowable 
.
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ap Configuration
is area of the Repeater Configuration view 
ows you to enable or disable the following 
ps.

k Traps
lows all packets indicating a change in link 
tus to be reported within the trap database. 
ssible menu selections are: Disable, Enable, 
d other.

gmentation Traps
lows all packets indicating a change in 
gmentation status to be reported within the 
p database. Possible menu selections are: 
sable, Enable, and other.

larm Configuration
is area of the Repeater Configuration view 
ovides configuration information on generating 
rms for the selected module. This area 

ntains the fields described below.

ebase
splays the user defined time interval, in 
conds, for the Traffic Threshold. The lowest 
owable value is 10.

Traffic Alarms
Allows you to enable or
Alarms.

Traffic Threshold
Displays the threshold
packets that can be tra
Timebase before gener
field is user-configurab

Collision Alarms
Allows you to enable o
Collision Alarms.

Collision Threshold
Displays the threshold
timebase which, once t
per good packet is exce
alarm. This value is us
range is 1 to 15 collisio

Broadcast Alarms
Allows you to enable o
Broadcast Alarms. 

Broadcast Threshold
Displays the threshold
timebase which, once t
received is exceeded, g
alarm. This value is us
range is 1 to ~4 billion
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e module ran out of 
uffer space) and could not 

xceed 1518 bytes (not 

Configuration
s Icon, select Ethernet Based 

 configuration information 
view also shares fields with 
figuration View (page 54) 
re covered there. The fields 
 specific information found 

-Negotiation is enabled for 
Negotiation is disabled the 
peed, duplex, and flow 
ed by their associated 
trol groups.

remote end of the link is 
tiation signaling or not. 
n f i g u r a t i o n V i e w s E t h e r n

e c t r u m E n t e r p r i s e M a n a g e r Page 58

ror Alarms
lows you to enable or disable detection of Error 
arms. Possible menu selections are: Enable and 
sable.

ror Threshold
splays the threshold value for the percentage of 
rors per good packet that may occur within the 
mebase before generating an error alarm. This 
lue is user-configurable from 1 to 100.

rror Source
is area of the Repeater Configuration view 
ovides a series of buttons that let you select the 
pes of errors to include in the error sum. The 
lectable error types are as described below.

C
ckets with bad Cyclical Redundancy Checks.

nts
packet that is one byte less than the standard 
hernet frame of 64 bytes (not including 
eamble).

W_Colls
llisions out of the standard window due to a 
twork problem.

gnment
isaligned packets detected.

No_Resource
The number of times th
resources (i.e., lack of b
accept packets.

Giants
Packets received that e
including preamble).

Ethernet Based
Access: From the Chassi
Configuration.

This view provides port
for GPIM models. This 
the Fast Ethernet Con
and the shared fields a
below detail the device
with this view.

Auto Negotiate Mode
Indicates whether Auto
a specific port. If Auto-
port will revert to the s
control settings specifi
leaves in the Flow Con

Remote Auto Signal
Indicates whether the 
operating in Auto-Nego
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w Control
e current or desired operational status of the 
ll-duplex flow control on this port. 

rt Type
ves the name of the device configured on this 
rt.

k Status
scribes the status of the link for the device 
nfigured on this port.

vertised Abilities
is field is described under the Fast Ethernet 
nfiguration View (page 54).
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SP

el Information View

Help

of Landscape VNMHost: Primary

Sys Up Time

Manufacturer

Device Type

Serial Number

ation View

Communication Information

Community Name

DCM TimeOut

DCM Retry

Poll/Log Information
Poll Interval

Polling Status

Mgmnt Protocol
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Model Information View

This section provides a brief description of the Model Information view available for the
6000 devices in SPECTRUM.

odel Information views provide descriptive and 
nfiguration information about SPECTRUM 
odels of individual devices, interfaces, and 
plications. Figure 17 shows an example of the 
odel Information view accessed from the Icon 
bviews menu for the 6E132_25 model’s Device 
n. Model Information views are also available 
 each of the Interface icons in the Interface 
vice and Device Topology views, and for each of 
e Application icons in the Application view. 
though these views may vary slightly depending 
 the particular entity being modeled, their basic 
out and content are similar for most 
ECTRUM management modules. Therefore 
ese views are described in the more detail in the 
ECTRUM Views documentation.

Figure 17: Mod

*File V iew

IP Address of type 6E132_25

Model Name

Contact

Description

Location

Net Addr

Prime-App

MM Version Number

MM Name

MM Part Number

Model Inform

General Information

Model Created By

Model Type

Model Creation Time

Model State

Security String
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h (if such a model does 
g AutoDiscovery one or 
 the network model. You 

iscovered network model to 
apabilities.

procedures described in 
used when making minor 
. This includes such 
lready discovered module 
mode or adding a new 
e network.

ing Started with 
or Administrators and 
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Modeling

This section describes how to manually model a 6C105 chassis and a SmartSwitch 60
chassis and place the resulting device icons in their proper SPECTRUM views.

troduction
e following topics are covered in this section:

AutoDiscovery vs. Manual Modeling (page 61)
Manual Modeling Overview (page 62)
Preparation for Modeling (page 63)
Modeling Using the Chassis IP (page 63)
Positioning the Chassis Device Icon (page 66)

utoDiscovery vs. Manual
odeling
ECTRUM’s AutoDiscovery is recommended if 
u are modeling a network for the first time or 
nt to discover and model a network segment 
er making changes to it. 

toDiscovery is not recommended for use when 
e SmartSwitch 6000 is in Mixed Management 
ode, see Management Modes (page 9).

Autodiscovery involves
router, bridge, or switc
exist) and then runnin
more times to complete
then refine your autod
improve management c

The manual modeling 
this section should be 
changes to the network
actions as placing an a
in Mixed Management 
chassis or module to th

Note:Note:

Refer to Gett
SPECTRUM f
How to Man
SPECTRUM f
AutoDiscove
network mod
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r proper device management, the module’s 
vice icons appear in a Topology view and you 

ay place the chassis’s Device icon in a Room 
cation view. This is true whether you use 
toDiscovery or manual modeling, In some 

stances, this may require you to copy and paste 
vice icons into the proper SPECTRUM views. 
e manual modeling instructions given in this 
ction describe how this is accomplished.

anual Modeling Overview
e following alternatives exist for modeling your 
twork components manually.

Modeling using the chassis IP address in a 
Location View. Create a chassis model within 
a Room Location view using the chassis’s IP 
address. Once the chassis is modeled, 
SPECTRUM’s distributed management 
feature identifies and models the modules 
contained in the chassis and places their 
Device icons in the chassis’s Container view. 
You then copy and paste the Device icons into 
the Topology view. 
Modeling using in the Topology view. You 
can also create the chassis IP address in the 
Topology view by modeling with the chassis’s 
IP address in the Topology view and all the 
models in the chassis will appear here. Locate 

the chassis Device 
Access the Find yo
View> Find. Select
can search for you
Location view and 
icon into the Room

Container View
Access: From the Icon S
Device icon, select Conta

This view (Figure 18) d
Device icons for each m
SPECTRUM and conta

Note:Note:

This only w
the distribu
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istrators and How to 
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ld also be familiar with any 
nd firmware requirements 
 chassis firmware 

the Chassis IP
 only be place in a Room 
m Location view is created 
rse level view and navigate 
 level, as described below.

el, select View > New View 

he top level of the Location 

odeling, the chassis and its 
dules must not be in Mixed 
 mode. Each module should 
 IP address or the chassis 
nfigured with a single IP 
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Figure 18: Chassis Container View Preparation for
Before modeling the ch
familiar with the proce
accessing views. Refer 
SPECTRUM for Admin
Manage Your Network
instructions. You shou
network management a
described in the 6C105
documentation. 

Modeling Using
The chassis model can
Location view. The Roo
by starting at the Unive
into the Room Location

1 At the Universe lev
> Location.

This places you at t
views.

* File View Help

Primary Landscape 0x00400000 - VNM Host -

Model One

6E122_26

Model Two

6E138_25

Model Three

6E233_49

Model Four

6H202_24

Model Five

6H122_16
Caution:Caution:

For proper m
installed mo
Management
have its own
should be co
address.
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re 21).

lding Location View
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Cancel
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Access the Edit mode and select Edit > New 
Model.

The Select Model Type dialog box displays 
(Figure 19).

Figure 19: Select Model Type Dialog Box

Select Building and then click OK.

The Creating Building dialog box displays 
(Figure 20).

Figure 20: Creati

4 Enter the Building
String (optional) an

The Building icon a
Location view (Figu

Figure 21: Bui

Select Model Type

CancelOK

Filter:

Country
Landscape
Region
Site

Building

Crea

OK

Please enter:

Building Name

Security String

* File Edit

Building Name

Primary Landscape 0
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 when the chassis Device 
 Room Location view.

Option
g a module or chassis 

Topology view, select File > 
iew in the Edit mode.

Model By IP.

ype dialog box displays,

s assigned to the module.

ity Name that has been 
the module. The default 
value is “public.” 

 the Device icon 
odule at the top of the 

 Edit to exit the Edit mode.

work administrator to verify 
munity Name has not been 
 “public” to another access 
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Exit the Edit mode and double-click the 
Building icon to open its Location view.

Access the Edit mode and select View > New 
Model.

The Select Model Type dialog box displays.

Select Room and then click OK.

The Room Creation dialog box displays.

Enter a Room name and a Security String 
(optional) and then click OK.

The Room icon displays in the Room Location 
view.

Exit the Edit mode.

This places you in the Room Location view, 
where you can create the chassis model.

Double-click the Room icon to open its 
Location view.

Access the Edit mode,

Select Edit > New Model.

The Select Model Type dialog box displays.

Select 6C105 and click OK.

The Creating 6C105 dialog box displays.

Enter the Network Address (IP) and click OK.

15 Exit the Edit mode
icon appears in the

New Model By IP
This option for modelin
proceeds as follows:

1 In the appropriate 
Edit to place the v

2 Select Edit > New 

The Select Model T

3 Enter the IP addres

4 Enter the Commun
assigned locally to 
Community Name 

5 Click OK.

SPECTRUM places
representing the m
Topology view.

6 Select File > Close

Note:Note:

See your net
that the Com
changed from
policy name.
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See Positioning the Chassis Device Icon, 
below, to properly locate the automatically 
created chassis Device icon.

ositioning the Chassis Device
on
me of the modeling procedures described above 
tomatically create a chassis Device icon. This 
n can be copied into a Room Location view.

Create a Room Location view using Steps 1 
through 10 in Modeling Using the Chassis IP 
(page 63).

To locate the chassis Device icon, activate the 
Topology view and select View > New View > 
Find.

Copy the chassis Device icon into the Room 
Location view as follows:

a Within the Find view, select File > Edit.

b Select 6C105.

c From the Edit menu, select Copy.

d Access the Room Location view and select 
File > Edit to enter the Edit mode.

e Select Paste.

The icon appears in the Room Location view.

f Exit the Edit mo
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